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Installation and Setup

To begin installation of Torchmate CAD insert the Torchmate CAD CD packaged with a security dongle. The
installer will automatically launch. The first prompt will be to select the setup language. This language is only
for the installer, Torchmate CAD menus are only in English.

Choose Setup Language El

Select the languane for the installation from
the choices below.

I

[ oK ] [ Cancel J

After selecting a language the installer will issue a reminder about inserting the security dongle. Follow the
instructions for the specific dongle being used.

InstallShield Wizard

USB Flash Dongle

If your package includes either
a Kingston or Orange-colored
dongle, then please connect it
now. Windows will automatically
detect the device, and you can
then click Next to continue.

If your package includes a Blue-
colored dongle, then please
connect it at the end of your
product install.

Insall5d [TV B |—
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A License File Query will request the license disk. The files are located on the dongle, which will appear as a
removable storage device, if the dongle is orange and located on the installation CD if the dongle is purple.

License File Query

Fleaze inzert the Licenze Dizk into pour CO ROM drive or
enter the corect path below and prezs OF. to continue.

Fath:
E:\ | Browsze... |
[mztalls hield

L ak. | Cancel |

Continue with the installation.

larchmate CAD Setup

Wealcome o the [nctall5keld Wizand fod Toschmate CAD

Thwe It ol khield® \wWizaed will nqtal Toechmate CAD on pour comptes, To continee, cick Bes

>

Install5 1) Back
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lTorchmate CAD Setup

License Agreement

Comporation.
ICADVEnk ). IF wou do not agree with thee tems. you should refum the softveare and
socunly device wathan 5 business dags of recept and pous money wall be:

ieaponaibabily bor the selection of the soffwane to achiowe your intended results, and for
the insballahon, use. and results cbianed biom the software.

NOTE: A secunly device accompanies and i speciically dedicaled to the softwane
ipurchased by wou and is requared bo be nstalled on pour computer at all mes during
i of the progianm 8o enduse propes operation of the softwans. i the secunty déwvice i
ot sholen of damaped by whabéver means, A ieplacemen] setuity denoes dedicalad ko
& replacernent mnwmmtmm:mmd&ﬁﬂﬁ&mm

@ | stoapl ke bems of e boanse sgeemen

® | do ol e b o Berie Aorsererl

Installs e « Black Hest »

lTorchmate CAD Setup

Choose Destinalion Location

Installs e « Black
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When prompted select “Full Instal”.

larchmate CAD Setup

Bramal Inctsl
The o vl matall ol Hhoss components reqursd lor Tonchmate LALY 1o un

s B s ] it

Install5 74 " <Beck et > Cancel

larchmate CAD Setup

i Program Foldes

Tl [N O Felid Tkt P,

st 57 " <Beck
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lTorchmate CAD Setup

Selup Stabus

Toechmate CAD i configurng pou new softvane ingtallation

Installs e . [Cancel

After Torchmate CAD is installed the installer will want to search for all fonts installed on the computer.
This is not necessary to run Torchmate CAD but allows all fonts installed on the computer to be accessed by

Torchmate CAD.

‘Whiglcrme b the Torchmate Fort Installstion 'Wiesed Touse alondin
Tarchmata & must be mataled

Chcking Contirue vall sla the matalaton of TneeTwpe fonts, CAD
WEF lonts, Conel 'WTH lonts and Adobes Teps 1 lonts

[ sie | [ o |
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lTorchmate CAD Setup

Ingtalls hicld Wizad Complete

O “ve, | ward o redat

B Mo, | vall icibid my compulter lalei

Femove sy chzkt hom thes dervas, ard Bhen chck Fruth bo complate sstup

Install& = ' i <ok N Foen P | cocel |

Torchmate CAD is now ready for use. If a purple security dongle is being used insert it after the computer has
restarted.
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Important Configuration Changes

Depending on the version of Torchmate CAD installed a few configuration changes need to be made to
allow for simpler creation of tool paths in Torchmate CAD. These changes once made will not need to be

adjusted in the future.

Wig M Help

Torchmate Sektup

10
Autamatic Save...
a Paletke
arid
ﬂ Reset Origin
Guides

Ll Warkspace Colars,
v Snap ko Material
Ruler Positions. ..

Toggle Units

iCuskorize Shortcuts
v Use InstantReplay

Multiple Instance

izeneral Preferences. .,
Export Error Tolerance. ..
Undo Setup. ..

Dialog Box Fonk Setup...

Selection Tool Setkings. ..
Sketch Tool Settings. ..
Impoark Bitmap Setup...
Display Units, ..

Bl e

Go to OPTIONS »» TORCHMATE SETUP P> TOOL PATH PREFERENCES
Ensure that GROUP TOOL PATHS WITH ORIGINALS is not checked.

Toal Path Preferences

30 Chetel
" Singhe el
1 Digudde o1

[ Gsoug losd patih vel organali
e dppdy peparstely

o Carcel |

|

THE NEWEST VERSION OF TORCHMATE CAD AND TORCHMATE CAD LITE
DO NOT NEED THIS CHANGE MADE.

(
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Go to MACHINE and ensure that USE EASY TEMPLATES is not checked.

Transform  Image  MWiew  Opkic

. Cutput.., Alk+P

i Machining Defaults
Tool Qptions. .. 1

—_—

Tiling. ..

Tool Library. ..
Material Library, ..

1

=

Use Easy Templates
iZut Template Wizard
_reake Tool Path »
apply Tool Path 3

Edit Start Point
Job Analysis

Torchmate CAD is now configured and ready for use. If the software is ever reinstalled these changes will
need to be made then.
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Overview of Menus

[ Torchmase CAL - Usgithed1.COL
Fie Edb Lypok Lmange Tearslonn [nege Wes Oplions Help
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@ Job PaIIet/

—Tool Pallet

Layer Color Pallet

Sheet Layer

Sheet Selectior\

4] vv ¥
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Rulers: The rulers sit on either side of the work area and provide a reference to the coordinates of a spot in

the work area.

Layer Color Pallet: Allows the color of an object to be changed; this is useful in keeping track of various
parts. The color of an object does not affect the cutting process at all and in most cases this is an unused
tab. Colors can be changed by double clicking on one of the colors, this opens a window to change the color

options.

Sheet Layer: The sheet layer is a guide used to differentiate multiple sheets of multiple objects. This bar like
the Layer Color Pallet does not affect the cutting process and is generally unused. The sheet layer is visible
when Show Fill is enabled in the View menu, by default the layer is transparent.

Job Pallet: Displays all of the document’s currently used layers. Allows all parts of a single layer to be

selected, replaced, or deleted.

Shortcut Bar: The shortcut bar contains icons that serve the same function as certain options in the
program menus. Generally these options are for functions that are used frequently. This menu can be
customized by right clicking on the icons and selecting Customize. Various functions can be added or

removed from the bar.

(

(12)
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Sheet Selection: This option is used to toggle between multiple sheets. Multiple sheets occur when nesting
or other options that will create additional sheets. This option enables these sheets to be paged through if
multiple sheets exist.

[ngi_i%t;,:zg.mz] % (.00 :| w000 j 100.00 %z% G 0.00 i|° !
=

- 52 vom 4 oo 2 oo
Object Tab Variable Tab Layer Color of Selected Object

Information Bar: The information bar contains basic information about a selected object. This bar contains
two main areas, the objects tab and the variable tab. The objects tab gives two bits of information, the
coordinates of the pointer in the ruler grid and how many and what type of objects are selected. This bar is
useful when determining what is selected and also if what is selected is the correct object. The variable tab
is a dynamic bar that will change with each tool and part selected. This bar displays options for various tools
when they are selected.

Tool Pallet: The bar on the left hand side of Torchmate CAD contains the pull out menus for basic drawing

tools as well as the means to manipulate them. Each tool will be further explained throughout this manual,
essentially any drawing from scratch will start here.

Select Tool =—>» %

?é, <«——Cut Tool

Measurement —_— ﬂ
Tools

& <«—Text Tools
Zoom Tools —>

‘ <«——\Weld Tools
Shape Tools ——> ﬂ

é <«———Node Edit Tools
[ ]

Scan Tools —— -«'*3.
| ]
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Navigation and Selection Methods

Being able to move around the drawing area and manipulate objects is the key to successful drawing. In

Torchmate CAD there are a few ways to simplify this process so that drawing can be done more efficiently.
Moving around the work area is done in a few ways. The scroll bars along the bottom and right of the area
can be used to pan the page. Another way is to use click the third mouse button this brings up a pan hand

that allows click and drag movement. On most computer mice the third mouse button will activate when
the scroll wheel is depressed.

T T

T o e | [

CEeE N WOY

- Ii
D 8
(LI
n.
Ll

Endlb gk rw
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The pan tool can also be accessed in the Zoom Tools menu. Also in the Zoom Tools menu are ways to
either zoom in or out. There are short cuts to all of these or they can be accessed from the menu.

‘ ‘ ‘ Q ‘?Fw_-'wl [@z<—Percent
ZOOr;olngUt / / \ V\‘\ Zoom

Zoom to Zoom to Previous Pan
Selected Object Material Blank Zoom  State

Zoom Shortcuts:
Zoom In: [F5]
Zoom Out: [F6]
Zoom to Selected Object: [F7]
Zoom to Material: [F8]
Pan State: 3" Mouse Button
Center Window on Current Mouse Location: [F11]
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Selection of objects can be crucial for certain drawing methods in Torchmate CAD. There are multiple ways
to select an object. Pressing the TAB key will select one object, pressing TAB repeatedly will cycle through
each object generally in the order they were created. A single object can also be selected simply by clicking
on the edge of the object. To ensure that the object is gets selected the mouse will change into a cross hair
when it is over the edge.

ey ——y———
Dt 1 vee on BT e T -_ﬂ o '-.
LR o [ e B 2y

\;Hﬁ- —Lor b MLYEY Y R

5] a 3 = = = = 0 = s == - P P = =]

Endlb gk wr
]

"
El B

LI -.....;;u-lmm:,:mmuﬂm“ﬂmuﬂmmmnmu-lululn':ﬁln;u

Said B
Multiple objects can be selected as well, the simplest way to do this is to click and drag with the ‘Selection
Tool’around the objects that are to be selected. Multiple objects can also be selected by using the ‘Shift’ key.
With this method begin by selecting one object then hold down ‘Shift’ on the keyboard; click on another
object both objects will now be selected. This method also works in reverse for deselecting a single object
when multiple objects are selected.

Fir A eoemd Bewgr Smive bewes b G Opes Sw

hamin 1 see ow GEW H e aEE oo du | O amm G
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When selecting multiple objects it can sometimes become ambiguous as to which ones are selected and
which are not. In Torchmate CAD there is a feature that when enabled highlights each selected object a
certain color. This allows for easy identification of selected objects.

To enable this feature go to OPTIONS > TORCHMATE SETUP > SELECTION TOOL SETTINGS.

Cptions MgE

Torchrate Setup General Preferences. ..
Auktormatic Save..., Export Errar Tolerance. ..
Palette r Undo Setup. ..
Garid r Dialog Box Fonk Setup. ..
i Reset Qrigin 5
N Guides ¥ Sketch Tool Settings. .. —
4 Workspace Colors. .. Import Bitmap Setup. .. L
v Snap to Makerial Display Units. ..
Ruler Positions. .. Tool Path Preferences
Toggle Units

Customize Shorkouts
v Use InstantReplay
Multiple Instance

Check the box labeled Highlight selected objects the Color Picker next to this option adjusts the color.

Selection Settings P§|

[v Use live cursor
Iv Usze Filed Region to Select

[ Usze default snapping range ﬂ

Snapping range [in pizelz]; |6 :ll
= Calar
[v Highlight selected abjects Ficker
Highlight size (in pisels]: [ j - m
Speed Scrolling

" No speed scrolling
* Permnit speed scraling while rmoving objects

" Always permit speed scraling
Freview Smoothing
[v Enable previews

On Stopped - Preview only after cursor stops moving

Lo - Only fast ghost presiews

o I B

Medium

High - Uzually ghost previews

¥ )

Ghost previews always uzed

THE NEWEST VERSION OF TORCHMATE CAD AND TORCHMATE CAD LITE
DO NOT NEED THIS CHANGE MADE.
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With this feature enabled any selected object will have a colored highlight around it for easy identification.
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Basic CAD Drawing

This section describes basic drawing of a simple square with a hole and how to prepare this shape to be cut.
Please refer to later sections of this manual for further explanation on topics discussed. The basic process
described here will be used in most drawings.

Creating a Shape:

The Torchmate CAD’s main screen has a TOOL PALLET along the left-hand side of the screen and an
INFORMATION BAR along the top. All drawing is done in the main screen defined by the rulers along the
margins. The top bar displays the size of the object, its position and scale. The left-hand tool bar contains
tools used for drawing and manipulating objects. The SHAPE TOOLS menu has a few simple shapes to start
most part drawings with (circle, oval, square, polygon, star, arrow, and arch).

To draw a shape select the type of shape from the SHAPE TOOLS menu. Move the mouse into the work area
click and hold, then drag the mouse while holding to define the shape. The size of the shape is not critical
as the shape will be sized to a desired dimension. The position on the grid is not important either, the final
positioning will be done when the part is cut, the only positioning that is critical in the CAD is the spacing
between parts.
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Sizing a Part:
When a part is selected the dimensions will be listed on the INFORMATION BAR along the top. To change

a size type in the desired value and press enter on the keypad, the size will change. To the right of the
dimensions is a small padlock that enables proportional scaling. If this is locked when one dimension is
changed then the other will change proportionally. If the padlock is unlocked then the dimensions can be

changed independently.
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Creating a Hole:

To add a hole to an object create a circle similar to how the square was created. As before the size and
position are not critical when creating the shape as they will be adjusted later.

Size the circle to the desired dimensions and move the shape to the correct position. To maintain a perfect

circle ensure that the padlock is locked.
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Once the circle and rectangle are sized and positioned the CAD needs to be told that two shapes are one
part. To do this select both objects, then go to ARRANGE P> MAKE PATH this will take all selected objects

and make them one part.
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To ensure that the CAD knows that the circle is actually a hole go to VIEW »> SHOW FILL the software will
display the part as it sees it. A correct part will have a filled in area where metal should be, holes will be

shown cut out of this filled in area.
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Creating a Tool Path

The final step in creating a part is to make a tool path. A tool path contains four bits of information that a
regular drawing does not contain cut order, lead ins, cut direction, and kerf compensation. There are three
types of tool paths male, female, and online the distinction will be described in depth in the tool path
section of this guide. For most applications a male tool path will be used. To make a tool path select the
object and go to MACHINE P> CREATE TOOL PATH »> MALE.
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In this menu ensure that the BASIC CUT tab has the DIRECTION as CLIMBING. On the LEAD IN/OUT tab
make an ARC lead in with a 0.2 inch radius. Press OK to create the tool path.

When a tool path is created it is placed directly on top of the original part. Before the tool path is sent to the
cutting software the original drawing must be removed. The easiest way to do this is hiding the tool path,
deleting everything on the screen, then making the tool path visible again. To do this begin by going to
VIEW and turning off SHOW TOOL PATHS, this hides the tool path from sight.

+ BEEWNEN Transform  Image  View Options  Help

. Cutput... alk-+p 100.00 i'z
¢ Machining Defaults =
Tool Options. .. 100.00 EI"/O
Tiling...
j_ Tool Library. ..
Ll Material Library. .. 16
Use Easy Templates
Cuk Template Wizard
Create Tool Path Online. ..
Apply Tool Path »
Delete Tool Path Female. ..

Edit Tool Path. ..

Convert to Online Tool Path
Edit Start Paink

Job Analysis
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Once the tool path is hidden select all objects on the screen and press delete on the keyboard. Then select
VIEW » SHOW TOOL PATHS this will reveal the tool path. This part is now ready to be exported to the

driver software for cutting.

Male: Default Male Template

Temp\ale] + BasicCut ¥ LeadIn/Out ]
Control
Iv Creats Lead In I Creats Lead Out
Lead in
@ g g
" Line " Online iy
: . |
Fiadius 0.200n j =
=] =]
£ I
Overlap: 0.00n j
™ Adjugt start point
;
Ej
Lock Template LChange | agK | Cancel Help

Exporting the File

Once a tool path has been created it must be sent to the Torchmate driver software to be cut. The driver
software imports a DXF file. In Torchmate CAD go to FILE > EXPORT.
This will bring up the export options. On this screen select the SAVE AS TYPE to be DXF POLY ARC).
Choose a location on the computer to save the file to then press SAVE.
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=8 Edit Layout

Mew
Open...
Zoam Qpen
Save

Save ks,

Arrange  Machine

Save Embedded File. ..

Irnpork, ..

Export. ..
Edit Template. ..

Duklick Fa DRE

Transform  Image

Chrl+M
Chrl+O

Crl+5

Yie

By default Torchmate CAD will have an option selected called Tool Paths Only. This option prevents any
object that is not a tool path from being exported. If it is necessary to export a non tool path object uncheck

this box.

Export File

Savein: |13 Duk Flles

Mp A ecent
Llacumeniz
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bl Compiiter

by Plalvwork File name:
Placee
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Customize
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Using Guides and Alignment Tools

Positioning of holes or spacing parts is essential to the creation of accurate cuts. This is primarily accom-
plished by the use of either guides or alignment tools. Understanding these tools allows part creation to be
quick and efficient.

Edit Guides

E—— ii i i B [ Add parallel line &t normal ¥ Lock Guides OK
I /'\-\-..{A"
el U £ offzet

Cancel

&dd

Y (1058 _|:| in

ke

Label Fant |

Guide Tool:

In Torchmate CAD guides are used to align and position objects at specific locations. The EDIT GUIDES
window is accessed by having no shapes selected and right clicking in the drawing area.

There are three types of guides, horizontal, vertical, and diagonal. The type of guide to be created is selected
with the three large buttons on the top left of the window. For a vertical or horizontal guide the position of
the guide is related to the ruler. To create a guide type in a position and press ADD the guide will be created
in the work area. Multiple guide lines can be created, the check box ADD PARALLEL LINE AT NORMAL
OFFSET will allow the creation of a line a certain specified distance from another line. This works on all three
types of guide lines a diagonal offset will be parallel to the original line.

Diagonal lines are created two ways either by specifying an angle and one point on the rulers to pass
through, or specifying two points to pass through.

Edit Guides

— i :f,::/ : W Add parallel line at nomal v Lock Guides oK
——=Z o //’ - affzet T |
ancel
= in
=] Add
Point 1

18.00 Change

el

Delete

L abel Forit | Delete Al
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Once guide lines are created press OK to exit the EDIT GUIDES window. The guides will be visible in the

work area.

Edit Guides ]

[ Add parallel line at normal

A affzet

|2 points j

[0.00,0] Angle:45.00
[2.08.0] Angle:45.00

Paint 1
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' |0.00 - in
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Delete Al

v Lock Guides
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= A
b F'lll:lé:nt : i QEHEHQE
]
. =i Delete
L

Guides are used to position shapes within the work area. To use a guide move a shape over the guide. As
the shape passes through the guide the edge or middle will illuminate indicating that the shape will snap to

the guide.

With a diagonal guide each corner as well as the center can be snapped to the guide. A combination of

diagonal and straight guides can be used as well.
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Guide Line Shortcuts:

Right click on a ruler to create a guide at that location.

When a shape is selected hold [Shift] and right-click on any of the nine nubs of the object a vertical and hori-
zontal guide line will be created at this point.

When in node editing hold [Shift] and right-click on any node to create intersecting guides at this point.

When moving a guide with the mouse hold [Shift] to have it move to the nearest grid line, by default this will
be one inch spacing.

Remove a guide by having nothing selected, press [Shift] and right click on the guide line.
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Alignment Tool

The alignment tool is used to align two or more objects to each other. The alignment tool allows shapes
to be moved automatically either centered or aligned to an edge. To access the alignment tool select the

No Align
Alignment Top

Vertical
Alignto  Alignto Alignment
Grid Selected  Options
=

Alignto  Alignto  Horizontal Align Left Align Right

Material ~Last Object Alignment Descenders  Margin
Options

Align  Align Equal
Center Bottom Spacing
Textasa

Object

-
o
—

N N

Ignore  Horizontal

objects to align then go to LAYOUT P> ARRANGE AND DISTRIBUTE > ALIGNMENT.

Position Option:

Align to Material: Uses the alignment option and references the material blank for location.

Align to Grid: Aligns the selected objects to the closest grid line using the alignment options.

Align to Last Object: Positions the selected pieces in reference to the last of the selected objects created.
Align to Selected: Shapes are aligned relative to each other.

Alignment Options: Shapes are aligned to the either the TOP, LEFT, CENTER, BOTTOM, or RIGHT using the
position options. EQUAL SPACING is used to space objects apart in the selected position option.

Text as Object: Enabled when using EQUAL VERTICAL SPACING. If a text entry has multiple lines, this will
cause each line to be considered separately.
Ignore Descenders: Active when using EQUAL HORIZONTAL SPACING. Aligning text will ignore parts of

THAE PN

the text that rest below the text line, such as’j,‘p, and ‘g

Margins: Enabled with ALIGN TO MATERIAL specifies a margin in the material blank to exclude parts from
this area.

Alignment Shortcuts:
Left Align: [Alt] + 1 or L
Center Vertically: [Alt] + 2 or E
Right Align: [Alt] + 3 orR
Top Align: [Alt] +4orT
Center Horizontally: [Alt] + 5 or C
Bottom Align: [Alt] + 6 or B
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Center Horizontally and Vertically: [Alt] + 7
In the ARRANGE AND DISTRIBUTE menu there are also shortcuts that allow quick alignments. Selecting

VLI Arrange Machine  Transform Image  Miew  Options  Help

SIEE |II MDI"IIE h I (P A AT "'l 4050 St = |?f
Arrange and Distribute alignment. .. i
c T align ko Baseling. .. z
rou ¥
a Align Chrl+k
1 align to Last Object FE
. Align to Sign Blank k L
Arraw... Align to Selected b L
Auko Layouk,
¥ Spacing +
SequUence L4 .
] Equal Spacing
Decorative Border ... . )
Weighted Spacing
Badges. ..
Templates 3
Clip Art 3o To k

Clip At Wigwer
Clip At Categories Setup

Comrmon Line Cukking L4

Material Size. ..
Material Blank Object

ALIGN from the menu will apply the last alignment options to the currently selected objects.

An object can also be positioned using any one of its corners to reference the shape’s position on the rulers.
When an object is selected the INFORMATION BAR will display a coordinate and have nine nubs related

to the four corners, four centers of the edges, and the center of the part. Selecting a nub will display the
coordinates on the ruler for that nub.
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Array and Badgse Tools

In certain instances it is necessaryto make many duplicates of tff& same part, and arrange them in a
particular way. This is done with two tools the array feature and badges. These two tools allow for multiple
parts to be created with a few parameters.

Array Tool:

The array tool is designed to make duplicates of a selected part spaced equally. The arrangement can be in a
grid, simply horizontal or vertical, diagonal, or radially around the original part. The array feature will ignore
the specified material area when arranging parts. To access the array options go to LAYOUT P> ARRAY.

=P Arrange Machine  Transform

{ Size | Move k
Arrange and Distribute b

Auko Lavaut, .,
Sequence L
Decorative Border. ..

Badges...
The array menu will appear on the top in the INFORMATION BAR. First select the type of array needed.

:

.“n Staggered

mea Hqarizantal
ooo .
288 arid

¢ On A
E:E On Arc with Raota

VERTICAL: Parts are arrayed in a vertical line. Space between parts, number of copies, and rotation of each
part can be specified.

STAGGERED: Objects are arrayed along a 45° angle. Vertical and horizontal space, number of copies, and
the rotation of each part can be adjusted.

HORIZONTAL: Parts and duplicated along a horizontal line. The number of copies, space between parts,
and rotation of each part can be specified.

GRID: Creates a grid of arrayed objects. The horizontal and vertical spacing, number of copies, and rotation
of each piece can be changed.

ON ARC: Arrays specify how many copies and a distance from the center, the parts are then arranged
equally around the original part equally spaced.

ON ARC WITH ROTATION: Creates the duplicates around the original equally spaced as the On Arc does,
but it will also ensure that the part’s base is facing toward the center.
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Vertical, Horizontal, Staggered, and Grid Arrays:

These array types share similar menus each having a spacing and number of copies component. Each also
contains an option to spin each copy a certain amount, or the incrementally spin the components and
specify the total spin of the last copy. The array options also have two types of spacing. One will space from
the edge of one object to the same edge of the next object, and the other will specify the space between
objects.

ffe | glfe I 0.3 :l e oy 3% Total = 1 =l

,

o 0o 2 Tatal': 1
Object Spacing Type Spacing Value Object Spin Type Number of Copies

U
I
OO

On Arc & On Arc With Rotation Arrays:

The on arc array options allow a part to be duplicated in a circle around the original. The starting angle
of the duplication as well as the end angle may be specified. The arc radius is also adjustable, this is the
distance from the center of the original to the center of the copies.

Stat 000 Ry 633 2

End ‘OO0 3

-
-

-

ER LN EX

Duplicate Angle Range and Radius

On Arc On Arc with Rotation
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Badges Tool:

The badges tool is designed to make a certain number of copies of a selected object onto the material blank.
To access the badges menu go to LAYOUT > BADGES.

Badge Setup E|
Musber of copies  [23 2| Maxcopiesperpage: |35
™ Lhee Scom Lines ™ UsePlate Feplacoabls ko S e
Cebor: ] = | frughisgh e 0 be changed]
I aberiad
™ Custiom Sie
Hesght 50,00 Wwish [1200
Mangen
Top (01 Bottam (0150
Left 0150 Right ||.'.|15:I
Spacig
Vestical |0.250 Hionzorkal |I:I..?'II

[T Group each badge
- )
~ e e [ Replacamert dats s

| [

|| e
ﬁ Totsl Humber of Pages [1
- EEEE 8% | o |

Badges will attempt to fill the material blank with duplicate copies of the part or parts selected. Badges will
only fill the material blank. In the Badge Setup window there are options for the number of copies to be
created, the size of the material, the margin around the material, and the spacing between each part. The
setup can also specify which corner Torchmate CAD will fill from.

Badges arranges the parts in a grid pattern at the specified spacing. Badges will also indicate in the upper
right corner of the configuration screen the total number of copies that will fit inside the material at the
current settings.
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Badges also has an option to replace text in a part with a specified list of text. This list may be either a

predefined text document, or may be specified when creating badges.

To create a changeable text field the badged object must contain a text field.

d

In the badges menu the select the text field to change for each part. If a text file has been created for the
list of replacement names the path can be specified. If this is left blank a new window will appear to specify
what each iteration of the part will have for text.
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Creating Text

Editing Text

Torchmate CAD allows various methods of editing text that can be used in conjunction with other tools to

create fabulous results.

To start editing text select the text tool from the left tool bar. Select where the text needs to go and click,

then type in the desired text.
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Once satisfied with the text in order to edit the text further it must be converted to a graphic. With the
text selected go to Arrange P> Text to Graphics. The letters are now individually selectable and can be

manipulated as any other drawing.

M-u.—a!'-’.r‘-—h-_-_i
o

e Sy Cam
b "'ll‘ .

= =

=1
i L]

Kbl a@DEw

£l
Vil P s 4

e -
= s DEHERIER EEE R R R R A LR T ERGE ARSI IR EEE TR EEEEE

EODEEE o

(

\

(33)

/

EDITING TEXT



Cutting Text Out of an Existing Shape

Once the text is created and converted to a graphic position it on the object being cut out of.
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Once positioned go to Arrange P> Make Path. What this function does is tell the CAD any overlapping part
is a cut out of the main part.
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Once a part is done it is always a good idea to go to View P> Show Fill. Show fill displays the part as the

computer sees it, white space indicating scrap areas. When working with text letters with cutouts like ‘O’ B,
‘A, etc. the cutout will fall out if it is not bridged.
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To bridge a letter simply draw a small rectangle over the area wanted to be bridged, select all components,
and complete a Basic Weld from the weld menu on the left hand tool bar.
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Welding Text to Objects

Text can be attached to simple or complex objects. Once the text is converted to graphics be sure that the
object slightly overlaps the text. Select all objects and text being joined and go to the weld tools menu. A
‘Basic Weld' will merge all overlapping objects and text together.
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Be sure to turn on show fill once all editing is done to ensure that the CAD software is interpreting the
drawing as it should be cut.
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Resizing Text

Text made in Torchmate CAD can be resized after it is converted to graphics. Simply select the letters
needing to be resized. The letters can be resized like any other object, (using the corner tabs when selected

or adjusting the scale from the top menu).
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Once the letters are resized they can be manipulated any way normal letters can.
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Joining Script Text

Node editing can be used to join script style text together to make a single cut for an entire word.

R T

o o 5 o =
F:"l"u res mal e em o e 1.." o o
TR I AT T

%mu i

A
a-
L]
E
- |8 [T
= ¥y
rF i | e
x |
b 1 i
= 55 —
t#
u
"
u
"
L B

w52 AT
CEDEEN (moT

To start convert the text to graphics, then move each letter close together so that they can be joined.
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Double clicking on a letter will open node editing. With node editing the letter can be manipulated to any

shape that is needed.
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Unselected nodes are blue in color while a selected node will be red. To select a node click onit, or drag a
selection box around a group of nodes. With a node or nodes selected they can be moved around.
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Be sure to overlap all script areas, so that welding can be done later.
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To join a script text together the goal is to overlap all letters and then weld the individual letters together.
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Once all letters overlap the text is ready for welding.
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Start by selecting all the letters, and then choose a basic weld.
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The letters are now all once piece and ready to be cut out. One thing to keep in mind is the thickness of the
bridges, if they are too thin when cut out they may bend or break.
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Fitting Text to an Arc

Text can be aligned to an arc to create arches or to follow a specific curve. These features are automatically
done with the optional ‘Pro Text’module. The instructions below show how to do this function without the

additional module.
The first step is to draw a circle or oval that the text needs to be fit around. Once the text is converted to

graphics each letter can be moved. Start by positioning the letters around the arc.
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The next step is to rotate each letter. When a letter is selected there are nine boxes around the part as well
as a small rotate tab, click on that and as the mouse is moved the letter will rotate.
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Once all the letters are rotated, delete the arc if it is not needed. This process can be done with shapes as

well as arcs, or any shape desired.
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Text Techniques

The techniques can be combined to create various effects.
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Scan Tools

(Not included in Torchmate CAD Lite)
Scan tools takes an image created from another source, such as a scanned image, bitmap, jpg, tiff, pdf,

png, or other image type, and converts it to a scalable vector format. This resulting scan may be edited in
Torchmate CAD and incorporated with any other elements in the CAD software.
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Accuscan:

With the image brought in scan tools can now be used. For most applications using Accuscan will be the
best option. What Accuscan does is look at an image and it will interpret any black shapes as parts that will
be kept as metal and any white parts of the drawing as scrap. Using a Centerline scan will have the software
look the drawing and try to interpret lines, if there was a thin square or box the software may interpret this
as a single line not the shape that was wanted.

Far L i B Swive et b s o

o rer m E e am e o ©Mm  oF
- OEH R bl bl |
LELT LT LR

Ebdl i @0k wl
0 T3 h

'_r:..--qu-q ] = g d
= s e DHEGIER B Er R R R R A LR T ERGE ARSI I GEEEREGEEEE RO EEEEE

( @ SCANTOOLS




Once Accuscan is selected the tool bar on the top will change to the scan tools features. The main features
used are two buttons called Trace Setup and Vectorization. Trace Setup specifies various tolerances

that the computer takes into account when interpreting the image. Vectorization takes the trace setup
numbers and runs a scan on the image creating a line drawing as the computer sees it with the current
settings. By varying the settings in the trace setup and running multiple scans each one can be compared
side by side to find the best line drawing for a particular image.

Fie [ Lmed dewge Fabew Saretem mage Sem Opiees Heln

QLI
UARA R B S e
L LY L]

£

-u...sle‘u..

COr Ba 8 (5 &) femiem

& ™ i - - [

£ -

Kl o #Dhnw

The trace setup for Accuscan has a few key settings. The main two are the line fit tolerance and corners.
These two features adjust how accurately the computer is trying to follow the image. The additional options
effect issues relating to the scanning of an image from a flatbed scanner. If there is significant dust on the
image the speckle filter can attempt to clean it up, the snap lines feature adjusts lines if the drawing was

crooked in the scanner, and small shape accuracy can compensate for low resolution scans.
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Once the trace setup is done clicking on the vectorization button creates the line trace. There are now two
objects on top of one another. Moving one off to the side the two can be compared.
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Repeating vectorization multiple times with different trace setups allows the comparison of settings in order
to determine the best one for a particular image. Each image brought in may have different trace setups

based on the quality of drawing and scan.
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Zooming in reveals small subtleties of the two scans, the left scan is done with 10 and 10 as the line fit
tolerances while the right image used 1 and 1.

Once the ideal trace has been done the next step is to clean up any necessary defects. The first part of the
process is to ungroup the trace so that each piece can be edited individually.
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To edit a particular part double click on the line and Torchmate CAD will enter a node editing. Generally
when an image is traced there will be an excessive amount of nodes, there a few ways to eliminate them.
The most straight forward way is to select the unneeded nodes and press delete, this can work well but if
there are hundreds of nodes this can be time consuming. Another method to select nodes to delete is while
in node editing select all of the nodes (F3, Ctrl-A, Edit P> Select All, or clicking with the arrow tool and
dragging a selection box around all nodes will select all of the nodes). Once all nodes are selected press the
U key; what the ‘U’ does is take all of the nodes selected and select every other one. With every other node
selected press delete, this process cleans up a significant amount of nodes in one sweep. Repeating this
step a few times can reduce the number of nodes to a manageable amount.
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Once the outside is done the letters need attention too. These can be done in the same way selecting nodes
and deleting them.
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Once the letter is to a point where the only nodes left define the corners the letter may not look correct,
almost ballooned sometimes. To correct this issue the nodes need to be changed. There are three types of
nodes, a circle node is a rounded node, a cross is a sharp node, and a triangle is a tangent node. With a node
selected, right click and move the mouse over the selection wanted and release.
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Once the nodes are squared reposition the nodes by selecting one and moving it. Once all the nodes are in

the correct position press the apply button.
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After all node editing is done the drawing is ready to be finalized.
il b s pemiericw ___________________EFE

g

wem  Smam o amn Sy

- - o em T
oo
- £

Dt 1
i
"

11 -
TR e
CIT L I L L LT e
E u L] v i 0 = = = = = .|
A
al
L]
dl
i
L
:l
L]
L] I
[ [
i o
! |
=AY i
% | &
L]
_l.i
1l 2] 5 ol A1 NG

EOOCEE o

SCANTOOLS



Select Show Fill from the View menu, the CAD software is now displaying the object as it sees it. In this case
the object is not correct as the letters are not visible.
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To remedy the problem select all and go to Arrange and Make Path this tells the computer all that is
selected is to be seen as one object. Now with show fill on the object appears as it should and is ready for

tool paths or further manipulation.
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Center Line

Center Line scanning is used when the scanned image is not shaded in but rather a line drawing.
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The Tracing Setup for center line scanning is similar to Accuscan’s. Tolerance will adjust how tightly the
image is followed; corner sensitivity will affect how close corners are cut.

Centerline Tracing Setup
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As before multiple scans can be done slightly changing the settings. This method allows for side by side

comparison of trace settings to find the ideal one for the particular scan.

M U cewmd ey Spbre edtes g S Opiees Sl

L e el o
LI YT Y BT B - Y= T

n I r I i - I = me

LA

Bkt

il g s B g B, i D

Bl

=rose e I DEECIER. SO R R R A LR R ERCE AR S NEE I EEENERNEEE RO R EEEE

FETE RN

Ehdh g @B
B s wmm = ‘B

Vil B ko o sty . Dl Ce

B v e

=cocs e DHEDIER SO R R R A LR T ERLE AL NG G EEE LRSS TR A EEEE

FETEEE

SCANTOOLS



Nesting

(Not included in Torchmate CAD Lite)

Torchmate CAD allows for multiple parts to automatically be rearranged maximizing the use of material

space. This feature is called nesting and can be used on any part drawn in Torchmate CAD.
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The nesting feature uses a defined material size as its guide to arranging parts.
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In the ‘Material Size’ window found in the ‘Layout’ menu the size and orientation of the work area can be

defined.

Before nesting can be done all of the objects must be selected, Torchmate CAD will only nest selected
objects. Go to Edit’and select‘Select All, CTRL-A and F3 can be used as shortcuts.

Lyl dewge Eaiws hedes e e (pos ey

i

Kh¢hG@Pb>r 5w aay

Material 5ize

(-]
ﬁfﬂmﬂ

1 2% & Landicaps
|' Cuarent 5 edecition:
[Cunton =]
Dimensons
whidth Heaght:

- o
E [120000 5 x [SO0000 ZJ inch

™ Resze obiecls proportonaly

advarced | [ ok ] caee |

S— e, Debed ss g N vmmen My oamn N
- P oonm 3 venm 2,8 |
B Lk
= 3 b - - - ¥ - n - L |
) ey, Tl u et ’
LC L] el __.l -
| il ek |
i !
| L W R e . e P Y g 0 ¥ e e
s o - > § - iiAeink=
. ! 1T A e jr*l:‘“l-‘ﬂ'- =
s Lo = - U AU A UG~ L3
Caghorsy iy |
. ) . i
L L > . : = i
£ i ] W a
' "L - 1 . M
K ( _— /
| I. I } X | -
h Y J Nl B E PR A
— ol - ¥

-

O Fhy

a

[ ST ETACE Y

| LV
ERICE R . |- el A Tl Lebel Tl B L Palal e ol ebaliad - ]l el ~iml=tal - e - Lr Bl el LA LA AL ]

(o)
\>8)

NESTING



To access the nesting options go to‘Arrange’and select ‘Nesting'
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Once nesting is selected the top tool bar will change to the nesting options.
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Keep Groups Include Tool

Intact Paths
Starting Rotation Clearance Allow Fill Sign
Corner Between Parts Mirrored Parts B|a§k
’E EIIJ :‘ Degrees |}| 4' EI 250 inches =] | [32
/ / 0125  inches I'I I‘l 1EIIJ inches "@
Nesting Nesting Error Factor NBlci,Ck Nest Parts in SglhecttA
Direction Border of Clearance esting Part’s Holes e

Starting Corner: Choose a corner that the nesting will originate from.

Nesting Direction: The direction that the nesting will proceed originating from the starting corner.
Rotation: Specifies how much each part will be rotated, this is a step rotation so if 60 degrees is specified
each part will be turned in 60 degree increments resulting in six possible orientations. The smaller the
number is (excluding zero) the more processes the computer will take calculating the nesting.

Nesting Border: This specifies the distance between parts and the edge of the material sheet.
Clearance Between Parts: The minimum distance maintained between parts once arranged.

Error Factor of Clearance: During the nesting process, approximations are made that are based on the
magnitude of shapes being nested. Setting a small Error Factor will produce more consistent spacing
between shapes but increase the processing time. A larger Error Factor will create less consistent spacing
but decrease the processing time of the nesting.

Allow Mirrored Parts: This allows objects to be flipped around to better nest them.

Keep Groups Intact: If this option is off grouped objects will be separated when nested.

Include Tool Paths: Accounts for the diameter of the tool path in the nesting calculations.

Fill Sign Blank: This option becomes available when only one object is selected. This will instruct Torchmate
CAD to fill the entire sheet with the selected part.

Block Nesting: When selected treats each object as a simple box.
Nest Parts in Part’s Holes: This option allows small parts to be moved into larger cutout areas.

Select a Sheet: Allows a specific sheet to be used to put the nesting results on.
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Once apply is selected the nesting process will begin. The process can take several minutes to complete
depending on the settings. Nesting can be done as many times as necessary with changes in settings or

additional parts added in.
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Advanced Shape Creation

Torchmate CAD allows for the creation of unique and creative parts. Certain parts require going beyond the
basic skills and using all or most of Torchmate CAD’s features.

The Shape Tools allow for simple shapes to be made, the simple shapes can be manipulated in order to
create more advanced parts.

@eECRD O

Any shape created with the shape tools will have two different tool bars along the top of the CAD window
that can be brought up. The standard shape tool bar is present for any shape or imported drawing when
first selected. This tool bar allows the position, scale, and rotation to be changed. The shape specific tool
bar is accessed by double clicking on a selected shape. The shape tool bar is only accessible for shapes
created from the Shape Tools menu, double clicking for all other shapes will enter the node editing mode.

Standard Shape Tool
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Selected Object(s): Displays the current objects selected.

Position Nubs: Correspond to one of the nine boxes that appear when an object is selected. When a nub is
selected the position of the object is displayed in relation to that nub.

Ruler Position: The current position on the selected nub on the rulers.

Overall Height and Width: The selected object’s current overall dimensions. These dimensions may be
changed by typing in a new dimension and pressing Enter on the keypad.

Object Scale: The current scale of the object. This will always display 100, however if a different value is
entered the object will scale to the new percentage.

Proportion Lock: When enabled the proportional lock will keep the ratio of the height and width the same
if one of the dimensions is changed. When unlocked the width and height may be changed independently.

Rotation: Allows an object to be rotated by a certain amount.

Shape Specific Tool Bars:
The simplest shape adjustments are with the circle and oval shapes. When a circle is created the shape tool
bar allows for the radius of the circle to be set as well as the center’s ruler position.
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Position of the Length of
Circle’s Center Radius

The oval shape tool has no options outside of the standard tool bar.

The rectangle tool bar allows the lower left corner position to be specified, the height and width, and the
rotation angle. All of these options can also be specified in the standard tool bar.
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Polygon Tool:
Position of the Polygon’s Center: The ruler position of the center of the polygon.

Number of Sides: Specifies how many sides the polygon will have between 3 and 30 sides may be specified.
Angle of Rotation: How many degrees the polygon will be rotated.

Chord Length: The distance from the center of the polygon to the tip.

Radius of Tips: The amount of rounding the tips of the polygon will have. Zero will give sharp tips.

Bulge of Sides: The value that the sides are curved at. A positive number will bulge out a negative in.

Position of the Number ChorcrI] Radius of Bulge of
, i Lengt i

Pongons\Center ofS|§|es i TTS Sides
wosta 4T 05 ANy um 2 _ l :

6 I 4 3o 4 O O oo i= 3
Yy /EE@&&’@% Ti’l ?‘fﬁ’ﬂl"ﬁ“@‘ﬁ
------- v I 0 /3 1 15 2 78 3 33 4 4
B~ S R I R N R
3~ | Angle of
A Rotation 1
A e
Q
@

ﬂ o
e
% <+
J2.
o |2
b
L

( @ ADVANCED SHAPE CREATION



Star Tool:
Position of the Stars’s Center: The ruler position of the center of the star.

Number of Points: Specifies how many sides the star will have.

Angle of Rotation: How many degrees the star will be rotated.

Length to the Points: The distance from the center of the star to the tip.

Length to the Inside: The distance from the center to the inside corner of the star.

Radius of Tips: The amount of rounding the tips of the star will have. Zero will give sharp tips.

Radius of the Inside: The radius of the inside corners. Zero will give a sharp corner.

Position of the Number Length Length Radius of Radius of
Star’s Center of Points to Points to Inside Tips Inside
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Arrow Tool:
Position of the Arrow: The ruler position of the center rear of the arrow.

Overall Length: How long the entire arrow is.

Length of Stem: Length of the thin part (stem) of the arrow.

Width of Head: The overall width of the arrow.

Width of Stem: Width of the thin part (stem) of the arrow.

Angle of Arrow: The amount of rotation the arrow has. Zero will result in an arrow that points to the right.
Angle of Tails: The angle at which the tails of the head are rotated.

Bulge of Tails: How far in or out the back end of the head bulges.

Bulge of Head: The amount the front edges of the arrow will bulge.

Radius of Point: The radius of the tip of the arrow.

Overall Width of Angle Bulge of Radius of
Length Head of the Head Point
Position of the Stem Stem AIM{W Angle of Bulge of
Arrow’s Rear Center Length Width Tails Tails
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Fan Tool:
Position of the Fan: The ruler position of the center of the fan.

Fan Angle: How much of a sweep the fan will have. 360° will result in a ring shape.
Rotation Angle: Rotation of the fan around its center.
Outer Radius: Distance from the center to the outside edge of the fan.

Fan Thickness: The overall distance from the outside edge to the inside edge of the fan.

Fan Angle Ouyter
Position of the Fan Rotation Radlius Fan Thickness
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Round Corner and Filet Round Corner:
On any shape in Torchmate CAD it is possible to round either all corners using Round Corner, or to round a
specific corner using Filet Round Corner. Both of these tools are found in the Transform menu.

Round Corner will only do all corners of a shape. When using the tool the user specifies the whether inside
or outside corners will be rounded and the radius of the rounded corners. Then pressing Apply will change
the shape and Close will exit the menu.
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Filet Round Corner allows a single or multiple corners to be rounded. To round a corner specify what the
radius of the corner should be, then click on the corner to be rounded. Once all of the corners that need to
be rounded are selected press Apply on the tool bar and then Close to exit. Miter will do a miter cut on the
corner at the specified radius rather than rounding the corner.
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Weld Tools:

The weld tools included with Torchmate CAD allow the combination of shapes to create cutouts or tabs
along with other shapes. To use a welding tool select both objects desired to be welded and then select the
appropriate weld. One thing to keep in mind while using the welding tools is that all three operate best
when only two objects are selected; weld tools also only work if the two objects overlap each other, even

just slightly.
@D

Basic Weld - A basic weld joins two objects together by merging where they overlap creating a single part.

AND Weld - The AND weld removes from both parts any section that is not overlapping leaving a single part
that consists of what was overlapping between the two original objects.

XOR Weld - The XOR weld takes the two original objects and removes from each object the parts that were
overlapping. In most cases this will result in two objects with some part removed. If the one object is fully
enclosed in the other object this will result in a part that is the same as if Make Path had been selected.

Original Objects Basic Weld AND Weld XOR Weld

In general it is best to follow a few guidelines when it comes to welding. These prevent unwanted results
in the welding process from happening especially when trying to weld two or more objects or objects with
gaps or open spaces.

General Welding Guidelines:

1) Weld only two objects at a time.

2) The two objects must overlap each other.

3) Both objects must be selected.

4)Both objects should be the same layer color. By default Black (Layer P2).

XOR Weld is particularly useful for creating slots in parts. Begin with the original shape that a slot needs

to be created in and a shape that represents the slot with some overlap. Select both objects and choose
XOR weld. This will create a slot in the original object and leave a small scrap piece that needs to simply be
deleted.
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Node Editin

Node editing is used two ways either to create anew object or to modign existing object. Nodes are
defined points that are connected by lines. In Torchmate CAD each node is generally blue and when
selected the node turns red. When a node is selected on the top bar there will be two coordinates that can
be changed to move the node to the desired point. When a node is deleted the nodes on either side will join
together. Creating a part from scratch is done in the node editing tool bar.

¥\ &

With the node edit tool selected simply click on the work area where the node is to be placed. Continue
clicking at each place where a node is to be. As each subsequent node is placed the line will extend along
the path. To exit out of node editing select the apply button, or if a closed shape is desired double click on
the starting point to connect the path fully.
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There are many distinctions to be made between nodes. On every shape there will be a single node that
has a small arrow originating from it. This node is the Start Point this node is the first in the sequence and
the direction of the arrow. If the drawing is not closed there will be two un-joined nodes, these nodes can
be joined to other shapes, or joined to each other. There are three types of nodes, Rounded, Tangent, and
Sharp. A rounded node defines a curve; this node references its two adjacent nodes for curve information
editing any of these nodes will change the dynamics of the curve. A sharp node is used to create the
straight lines and angle changes between lines, sharp nodes are the simplest nodes as they basically pin the
curve to a point. A tangent node is used to transition between rounded nodes to sharp nodes smoothly.

Corner Node Tangent Node

Start

Point Rounded Node—™

Un-joined
Nodes

When a node is selected additional features can be accessed by right clicking and holding. Depending on
the image type there will be up to eight options. Move the mouse over the option desired and release the
right mouse button, this will select the option highlighted.

Join Convert to Rounded

\ l / Node

+* @

Change Path Direction—> @ f <—— Make Selected Node the Start

ﬁ ‘|':| 1 Point

T

Delete Selected Break Convert to Tangent Node
Node

- \

Change to Sharp Node
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When working with nodes there are numerous keyboard short cuts these shortcuts are only active when
working in node editing mode..

Node Editing Shortcuts:

A - Create a new node where the mouse pointer is currently located.

C - Cycle the node between sharp, tangent, and rounded.

R - Removes the selected node.

D - Deselects the current node(s)

K- Selects the node closest to the mouse pointer.

F3 - Selects all nodes that make up the shape.

Ctrl + A - Selects all nodes that make up the shape.

Alt + F3 - Inverse selects all nodes

U - Takes the currently selected group of nodes and deselects every other node.

L - Sets the ruler’s zero location at the currently selected node.

G - Sets the grid size to be the distance from the ruler’s zero and the selected node.
S - Moves the selected node to the closest grid line intersection.

H - Moves the selected node to the closest horizontal grid line.

V - Moves the selected node to the closest vertical grid line.

J- Joins the selected nodes together if they are un-joined nodes.
B - Breaks the selected node into two un-joined nodes.
T - Toggles the starting point of the node loop to the currently selected node.

O- Creates a perfect circle of nodes centered at the average center for a node loop and the
diameter of the average distance of nodes away from the center

Ctrl + Z - Undoes the last action.
Ctrl +Y - Redoes a previously undone action.

Shift + Right Click - When performing this action at a node a pair of guide lines will be
created at the node, one vertical one horizontal.
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Node editing is one way to join two unrelated objects together. To get into node editing double click on the
shape. Initially the two objects can be edited but not at the same time.
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To tell the computer to think of both objects as a single part so that all nodes can be edited at once select

both objects and go to ‘Arrange’ and select ‘Make Path’. With the paths joined the next step is to edit the
nodes to create a bridge between the parts.
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Begin by breaking the nodes apart, select each node individually, right click, and choose Break.
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Once the nodes have been broken they can be moved closer to each other. To join the nodes to other
broken nodes select both nodes, to do this either draw a selection box around both or hold down the shift
key as each node is selected. Once both are selected right click and choose Join. Once both sides of the
bridge are joined there is a line left over, this can be thought of as scrap. This scrap piece can be removed a

few ways, if it is a fairly simple shape the easiest way is to simply delete the nodes.
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If the shape is more complex the way to delete the scrap is to break the path. Select the part and go to
Arrange P> Break Path. This separates any un-joined parts into distinct objects. With the objects separated

the scrap can be selected and then deleted.
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Ways of Positioning Nodes:

Torchmate CAD has several ways to position nodes in the work area. Depending on the part being created
one method will be better than another. When a node is selected the top tool bar will display two numbers
and a few buttons underneath these numbers.

116 4 oo
Absolute Mode —> E;:: ﬁ ;

+--3 <€—XY Coordinates

Relative Mode Polar Coordinates

XY Coordinates:

Using the XY coordinate system in Absolute mode will display the nodes position on the rulers. When using
XY coordinates with Relative mode the CAD will display how far over and up or down one node is from the
previous node.

XY Coordinates - Absolute Mode XY Coordinates - Relative Mode
A
Y Distance
from Zero +——— X Djstance fro
Last Point
X Distance
from Zero
s 3> et —t —

Polar Coordinates:
Polar coordinates us an angle and distance to determine where a node is. In Absolute mode it is measured
from the zero of the ruler, in Relative mode it is from the previous point in the node loop. With polar
coordinates directly right is measured as zero degrees and straight up will be 90 degrees.

Polar Coordinates - Absolute Mode Polar Coordinates - Relative Mode

istance from

Distance Last Point

fr Zero

Angle from
Last Point
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Polyarc Node Editing:

Torchmate CAD has two types of objects Polygon or Polyarc. In general most objects created in Torchmate
CAD will be polygons. To convert the object to polyarc go to Arrange P> Convert to > Polyarc. Likewise
through this menu a polyarc could be converted back to a polygon.

When node editing a Polyarc object there is only one type of node. Each node is positioned by the same
coordinates as the polygon nodes. The position options also contain a field to set the curvature between
each node either as an Arc Bulge or an Arc Radius. Arc Bulge is a measure of the distance from an

imaginary straight line between the two nodes and the center of the actual lines curve. Arc Radius is the
radius of curvature between the two nodes.

Two shapes one with an arc bulge of 3.5” one with an arc radius of 3.5”
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Creating a Part from a Dimension

Drawing

In some cases a part may be provided in a printed drawing that can not be scanned, imported, or otherwise
directly imported into Torchmate CAD. If the dimension of the part are labeled the part can be drawn
in Torchmate CAD. Using a combination of node editing, shapes, and guide lines it is possible to draw
essentially any shape from scratch in Torchmate CAD.

The example below outlines how to draw a part given only the dimensions of the part and a drawing.
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Begin the drawing by roughing out the outline using nodes. It is not important to have an exact shape at
this point.
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Start with one reference point on the dimension drawing, generally a corner is best for this but any point
that most components can be referenced from will work. For the drawing shown the lower left corner will
be used. This node will be set to (0,0) on the rulers.
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From this zero point the drawing indicates that the left edge of the part is 4” high to the top. At this stage of
the drawing the rounded corner is not going to be drawn and will be added later. Using Absolute and XY
Coordinates set the top left node at (0,4). As mentioned in the Node Editing section absolute mode used
the position on the rulers to position a node. For most parts absolute or relative mode would be acceptable
to use. Relative mode defines the position of one node based on its distance from the previous node. In the
case of this parts second node the relative coordinates would be (4,0) meaning it went left-right zero inches
and up four inches.
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Working around the part in a clockwise direction the next point would be at (2,4) on the rulers using
absolute mode. Relative mode could also be used in which case the coordinates would be (2,0).
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The next node drops into the part a quarter inch, the absolute coordinates would be (2,3.75) while the

relative coordinates would be (0,-0.25).
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As the node positioning continues it is perfectly acceptable to switch back and forth between relative and
absolute coordinates. For the next nodes especially when there are small changes relative can be easier to
work with. For the next node the absolute coordinates would be (3.5,3.75) the relative would be (1.5,0).
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For the next section the node makes a transition at an angle. For this part the angle is a simple 45°, absolute
or relative with the XY coordinates would be fine in this case. If the angle had been specified with the
distance of the leg then polar and relative could have been used. For this node the absolute coordinates are

(3.75,4.00) the relative coordinates are (0.25,0.25).
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Continuing to work around the points in a similar fashion will result in an outline of the part that is ready
to be finalized. Listed below are the points for each node in both Absolute and Relative modes using XY

Coordinates.
(2,4) (3.75,4) (5.25,4)
(0,4) (2,0) (0.25,2.25) (1.5,0)
(0,4) ¥
(2,3.75) (3.5,3.75)
(0,-0.25) (1.5,0)
(2.75,2.25) (3.5,2.25)
(-1.5,0) (-0.25,0.25)
= (5.25,2)
(1.5,2) (2,2) 3 7'5 2) (0,-2)
-0.50) (0,-.25) (-1.5,0)
(0,0) (1.5,0)
(0,00 (0,-2)
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To finish the outside go to Transform P> Filet Round Corner. Set the radius as 1”and press Apply. Then
click on the corner that has the radius specified in the drawing and click, press Apply then Close. This will

add a one inch radius on the corner.
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Repeat the same process but for a 0.25” radius on the lower right corner of the part. For this corner select
the Miter check box in the Filet Round Corner menu.
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The outside is now complete. To add the hole begin by creating two guide lines to center the circle. Based
on the drawing the vertical guide line should be placed one inch from the left edge. Since the left edge is at
0 on the ruler place this guide at 1”. The horizontal guide is one inch from the top edge of the part, the top

edge is at 4” on the ruler, place this guide at 3"
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Draw a 1" diameter circle and place it at the intersection of the guide lines.
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The slot of the part will be positioned the same way. Examining the drawing the slot and the recently
created hole are centered vertically to each other so the same horizontal guide line may be used. For the
vertical guide line the drawing indicates that the slot is 2" from the right edge. This dimension indicates

where the center of the radius of the slot’s edge is. The actual edge of the rounded part of the slot is 0.125

7

closer to the right edge. This would put a guide line at 3.375” on the ruler.
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To draw the slot start with a rectangle that includes the curved sides, from the drawing this rectangle would
be 0.25"tall and 1.25”long. With the rectangle selected go to Transform P> Round Corner and enter a

radius of 0.125” and press Apply then
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Position the slot on the guide lines.
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All of the components of the part are placed in position. Select all components (Edit > Select All, F3, drag a
selection box, Ctrl+A) then go to Arrange P> Make Path. This will tell Torchmate CAD that the components
selected make up the part.
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To ensure that Torchmate CAD recognizes the part correctly go to View P Show Fill. This will fill the part in
where it perceives metal to be.
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This part is now ready to have a tool path created, be nested, or any other process in Torchmate CAD.
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Understanding Paths

In Torchmate CAD a path can mean a few things mostly it refers t8either a tool path or an object. When a
path refers to an object the path is essentially the whole part. For simple shapes the path is just one object.
Once a part contains holes or cut outs then the path contains multiple shapes. In the Torchmate CAD the
path of an object can be broken, connected, or made all path options are accessed from the Arrange menu.
Make Path takes multiple objects and tells the CAD to consider them as a single part. Make path is used
primarily to create holes in objects. Start with an outline and a few holes.

The part when it is just created is four separate objects the objects need to be merged together to one part.
Select all objects that compose the part, then go to Arrange and select Make Path.
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When a path is made all of the objects will become one. At this point the object can have a tool path
created, be nested, or any other operation. It is as far as Torchmate CAD is concerned one object. As such
when a tool path is created the cut order and tool offset will be specified correctly.
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If additional slots holes or cuts need to be added they simply can by drawing the new object and making
a path again. Likewise if an object needs to be removed going to Arrange and selecting Break Path with

separate the outside object from all of the inside ones.
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Once a path is broken the objects that make up the part are free to be edited. For example a slot can be
removed. Prior to making a tool path be sure to make a path again to ensure that Torchmate CAD considers
the part one object and verify with Show Fill that it sees holes correctly.
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Importing DXF drawings from other
programs

Torchmate CAD is able to import many file types, however the file type used universally to exchange
drawing files from one design program to another is the DXF format. To bring a DXF, or any other file type,
into Torchmate CAD go to File P Import and select the file from the computer directory.

Different design programs import with slightly different information, some may have dimensions, hole
center points, sheet information, or other notations. When brought into Torchmate CAD these additional
items are not necessary and will need to be removed prior to creating tool paths. In most cases these
additions are separate objects and are easily deleted.
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In some cases there may be an outside shape that represents a sheet border. As this is a closed shape
Torchmate CAD may interpret this as a shape and make a path on it. It may be necessary to break path on
an object to separate unwanted parts from what the finished parts should be.

An imported DXF may also have been created with multiple layers. These may import in as different colors.

It is important that the part be set to the same color before editing it. To change the color select all parts
(Ctrl+A, F3, drag a selection box, or Edit P> Select All) then select the black color tab from the bottom row.
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Some design programs may also write closed shapes with a slight difference. This can lead to broken loops
that can be seen in node editing. These can be closed up manually or by using Connect Path from the
Arrange menu. Connect Path attempts to close gaps that exist in the shape.
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Once a shape is ready to cut it will appear with Show Fill on as a solid shape where metal should be.

Checking Show Fill and node loops ensure that the part will cut as drawn.
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Creating Tool Paths

Creating a tool path is the last step in cutting a part. Tool paths have been covered briefly in the Basic CAD
Drawing Section however there are many options that allow for the best cuts possible.

When a tool path is created in Torchmate CAD there are three main tabs that appear in the main screen. .
The first tab is called Template this tab may be used but will not affect the tool paths if it is never used. Itis a
way of organizing presets form the other two tabs. It is recommended to not use the Template tab unless
most functions in Torchmate CAD are fully understood, this option may change settings that could
cause frustration otherwise. If this tab is used what it stores is the information from the other two tabs as a
material. For instance the settings can be set for one thickness, once the settings are made selecting change
on the bottom row of buttons updates the selected material so that in the future the settings load with the
specific material. Again if nothing is ever changed on this page the tool paths will never be affected.
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The second tab is called Basic Cut this tab controls the tool being used as well as the shape of the cut. The
tool pull down menu allows any tool from the tool library to be selected. The tool is what defines the offset
to be used. Direction specifies the motion of the tool around the tool path. Conventional will create cuts
so that an outside cut travels counter-clockwise and inside cuts will be clockwise, Climbing will create the
opposite direction tool paths. For plasma cutting a Climbing cut should be used, for routing generally a
Conventional cut would be used but this can vary based on the bit used. The Tool Path Cornering option
allows for sharp or rounded corners to be created, in almost all instances a sharp corner is desirable. Move
Control is used if the g-code is being output from the Torchmate CAD in most cases this will be unused.

( @ CREATING TOOL PATHS



The third tab is Lead In/Out and controls all aspects of lead ins and outs. The check boxes at the top enable
alead in, alead out or both. For either type there is a choice between Arc or Line. When an Arc is selected
a radius can be specified this is the length of the lead away from the actual cut. For a Line both a length
and an angle need to be specified, this angle is in reference to the start point so a 90 degree angle will be
perpendicular to the cut path. For lead ins an Online lead can also be selected this is a lead in that will
pierce on the part just a certain distance back from the start point; as the pierce is on the actual cut this
type is generally not used. Overlap is used to continue cutting past the start point before finishing a cut,
this is used sometimes in oxy fuel cuts or with some plasma cutters that have a tendency to not finish a cut
completely. Finally on this tab is Adjust Start Point this allows for rough relocation of leads to the corner
specified.

Male: Default Male Template rz|
Template] + Basic Cut + Lead In/Out l
Contral
[¥ Create Lead In I” Create Lead Out
Lead in
" Arc o
v Lln& " Online o r
Length [ 0.250in %] =
. =l =
Angle: a0 i =

Overlap: 0.000 in ﬂ

I~ Adjust start point

Lock Template | | | QK | Cancel | Help |

Tool paths come in three varieties male, female, and online. The difference has to do with how the tool
paths are offset from the original drawing. When cutting with plasma there is a certain amount of material
eaten away this is called the kerf. In order to maintain the dimensions of a drawing the tool path needs to
be offset from the drawing. An outside cut will use a male tool path and an inside cut will use a female tool
path. An online tool path does not offset for any kerf and simply created a tool path along the center line of
the drawing. Lead ins and lead outs are also created based on these offsets.

Plasma Path

! /
Original
Drawing

Male Female Online
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For plasma cutting it is generally a good idea to create a lead in. What a lead in does is move the pierce
point of a cut away from the finished edge and into an area of scrap. This prevents a dimple from being
created on the part where the pierce occurred. In Torchmate CAD when a male or female tool path is made
the lead in will be created to coincide with the offset direction. With plasma lead outs are generally not
used especially if a height control is being used. If a lead out were used the part would finish cutting and
then go to the lead out, the scrap piece may shift or fall out the arc will attempt to go somewhere this will
result in the torch either diving down to follow the falling slug or the arc jumping to the part edge causing a
divot. Oxy fuel torches can use a lead out to do common line cutting or in general to ensure a full sever.

Torchmate CAD allows for two types of lead ins to be created Arc and Line. In most cases the difference
between an arc lead in and a line lead in comes down to personal preference. The area where one would be
preferred to another is when cutting inside holes

Pierce Point Pierce Point

Line Lead In Arc Lead In

Cut Direction Cut Direction

Transition Area Transition Area

For a well calibrated table with minimal backlash a line lead in should be used, this will result in a cleaner
transition area. The issue with an arc lead in occurs when the plasma’s path comes around to finish the cut;
it will encounter an area that has been partially cut on, and this can result in a divot or excess slag forming in
the transition area. In outside cuts or non-circle inside cuts the lead in type generally will make no difference
to the finished quality.
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Tool Path Sequencing

Torchmate CAD automatically sequences the insides and outsides of cuts, however it may be necessary
to sequence the order that individual parts are cut. This can be done numerous ways each method being
advantageous depending on the parts being sequenced. Most methods begin in the Layout menu under

Sequence. Start Sequence begins the order on a currently selected part.
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Click on each part in the order that they should be cut. Once finished click away from the parts.
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Start Sequence By Vector is similar to Start Sequence except instead of clicking on each part it is possible
to click across multiple parts and Torchmate CAD will sequence from the first part to the last along the path.
This allows to sequence multiple parts with just a few clicks especially if they are in rows.
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Start Sequence By List will display a list of all parts in the order that they will be cut out in. The parts may
be moved either up or down the list to change cut order. When a part is selected on the list it will appear in

the work area with a red box around it.
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Start Sequence By Trait will display a menu with pull downs for various traits that a part may have. The
parts may be ordered by Tool (plasma, plate marker, ect) , Material (set in the template menu), Depth

(for routing), X by Y (smallest horizontal dimension fist then vertical dimension), Y by X (smallest vertical
dimension fist then horizontal dimension), Nearest (to the selected part), Current, Smallest to Largest,
Largest to Smallest, Cut Type (conventional or climbing). Sequence by Trait can be useful when multiple
tools are going to be used and all of one tool must be completed first, for example marking a plate before

cutting.
Sort Tool Paths

Sort prioity -
1 [T

2 |Material =l

3 |Depth =l

4 %y =l

Sart arder [draq for changing the order of the elements]

Plasma

With all types of sequencing fine tuning or just a double check can be done by going to View u Show Tool
Path Viewer. This will display a small dialog box that allows Show Order to be checked. This will place a small
number next to each part. The order can be changed by double clicking on a part and setting the position
as the sequence the part should be cut.
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Kerf Compensation

Depending on the amperage, voltage, and consumable tips you are using, the width of your cut (or Kerf)
will be directly effected. If your image or part requires precise cutting, you may want to compensate for the
width of the cut created.

When you create a tool path, a new offset path is created (on the outside of the path for male cuts or on the
inside for female cuts) which is half the kerf width from the original path. This allows the cut part to maintain
the original dimensions.

In the Machine menu, click on the option for Tool Library to open the window below.

Select Plasma in the type box. The Parameters dialog allows you to change the settings for D1. This value
specifies the kerf width used for compensation.

Take an actual measurement of your cut width, either with calipers or a ruler, to determine the value to enter
in the D1 box. Then click Update. This resets the kerf compensation for every tool path you create, until you
reset it another time.

For different tool configurations, such as different amperage nozzles, you can type in a tool name and an
offset, and click Add. This adds a new tool to your Tool Library. You can add as many tools to the library as
necessary. That way, when you change tools, that tool’s kerf compensation gets updated, too.

Tools Library ﬁ

—Mame —Type

Plazma I Plazma bl I

045
1/8 inch mild zteel 40 amp tip

I:I:-:E-.-’-'-.cetilene

Flatemarker

Parameters

Pricrity

[ Filter By Type

Aydd Update Delete Cloze
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Continuous Line Cutting

Continuous line cutting is a method of drawing that links some or all of the tool paths together as one single
path. This is useful when working with thick plate using oxy fuel or when cutting with plasma and using an
edge start method. In both these cases restarting a cut in the middle of the plate can take an upwards of

30 or more seconds or may be impossible. Continuous line cutting allows the tool to cut from one part to
the next without turning off. Keep in mind that the path may cross over itself while doing this, with plasma
this may cause the torch to go out and need to be restarted. Continuous line cutting uses a lead in and lead
out for each part, with the lead out of one part connected to the lead in of the next. The most difficult part
of common line cutting is positioning each part so that the travel distance between parts is minimized as
cutting thick plate is generally at very slow speeds.

Due to consumable wear, chance of arc going out, and arc voltage height control diving continuous
line cutting is NOT recommended for the plasma cutting process.

To continuous line cut begin by drawing the parts and laying them out on a sheet. Create a tool path with
lead ins and lead outs, for the sake of clarity make them with different lengths or angles so they can be
distinguished.
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Edit each tool path so that the lead ins and outs are near each other.
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Select all of the tool paths, go to Arrange P> Make Path. This converts the tool path back to a polygon but
allows the parts to be joined together.
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Double click on the parts to enter node editing. Join the lead in of one part to the lead out of another by
selecting the two nodes, right-click, and select Join (middle-top option).
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By joining the nodes occasionally the cut direction will change, to reverse it select the node that should be
the starting point, right-click, and select Set Start Point (the right-middle option).
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Keep in mind when using common line cutting with plasma cutting the plasma can extinguish when
traveling over an already cut area. When cutting parts with holes the holes will need to be created
separately and cut order will have to be edited before cutting.
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